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IMPORTANT: PREMIUM SCHEDULING FEES

ProctorU charges additional fees for Same Day and Next Day Exams as listed below:

Same Day Exams: $12 Premium Fee.
Next Day Exams: S8 Premium Fee.
Exams 48hrs — 72hrs: S4 Premium Fee.

These fees are paid directly to ProctorU at time of scheduling, not to Always Food Safe.
NO ADDITIONAL CHARGES WHEN YOU SCHEDULE YOUR EXAM THREE DAYS IN ADVANCE

Please plan and schedule your exam at least three days in advance!



Activated Courses

od Protection Manager - All # ACTVATE CouRSE
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Complete the final exam to recieve your certificate
B VIEW LEARMER MATERIAL

VIEW INTRO MATERIAL

ACTIVATE
EXAM




Exam Activation

Please review and agree to the important information below about your proctor method choice.

You have chosen:

How it works:

Approximate wait:

Location:

Remote proctoring

At your scheduled exam time, you will log into ProctorU to connect with a proctor.
Once connected, they will verify your identity by checking your photo ID, and make
sure your computer, microphone, and webcam are ready for the examination. Your
proctor will stay with you throughout the duration of the exam, monitoring exam
conditions to ensure you have a smooth testing experience and to ensure no
cheating occurs. You will not be allowed breaks during the exam, including going to
the restroom.

0 - 4 days

Standard scheduling is included at no additional cost and allows you to book
your exam session as soon as 72 hours in advance. If you wish, the following
premium scheduling_ options can be purchased at the time of scheduling,
subject to availability:

« Additional fee for sessions 24 - 72 hours in the future: $8
« Additional fee for sessions less than 24 hours in the future: $12

If you require accommodations such as translators or extra time to take the
exam, please contact Always Food Safe at least 10 days before your scheduled
session for review and approval.

You can choose any place you like, as long as it meets the following guidelines:

The test room must be quiet and free of interruptions, with no one else present, free
of objects that a test-taker might use for assistance on the exam (such as phones,
another computer, a second display, tablets, notebooks, and pens/pencils)

‘When you connect with the proctor, they will ask you to pan your webcam around the
roolm to make sure all prohibited items are removed prior to starting your exam

Exam Activation

Language Name On Certificate:

English Lisa 'z

Phone Number: 1112223333

Address Confirmation

Address Line 1

Address Line 2
City

Zip Code:

Zip Code




CREATE AN ACCOUNT WITH “ProctorU”

proctor proctor

My Sessions My -Cal'to My Orders  Support &' Balance: $0.00 My Sessions My Carto My Orders  Support & Balance: $0.00 My Sessions My 'CEItD My Orders  Support &

Terms & Conditions

Reset your password

Are you an EEA citizen and/or a

current EEA resident? Terms & Conditions Password *

Must be between & and 16 characters long

Must include 1 lowercase, 1 uppercase character, and 1 digit
These Terms of Service ("Terms") govern your access to and use of ProctorU Inc.’s

Must not be equal to username, email, phone number, first
Submit ("Proctorl)”, "We", or "Our”) website(s), browser extensions, platfoerms, applications, name. or last name
and other services (collectively, our “Services”). These Terms also apply to any Must not have the same character repeat more than 2 times
information, text, audio, video, images. graphics, code, extensions, or other materials

created uploaded, downloaded, transferred or otherwise appearing on or connected
- y R . . Password
with the Services when you interact with ProctorU, including recordings of any test ) _
B " o confirmation *
sessions (collectively referred to as "Content”).

1. Using ProctorU’s Services

Update Password

[ By checking this box, you agree to ProctorU's Terms of 5
Privacy Policy

Accept Terms

My Account Enrollments Proctorl My Account Enrollments Proctorl My Account Enrollments

Account Settings Always Food Safe

Password Settings

Matification Settings

About &
Support &
Privacy Policy &

Terms of Service &

Account Settings

Password Settings

Notification Settings

Always Food Safe

About
Support &
Privacy Policy &

Terms of Service &

Account Settings Always Food Safe
Password Settings

Notification Settings




COMPLETE YOUR INFORMATION
AND SCHEDULE YOUR EXAM

proctor B Paulo Homem ~ proctor

Balance: 50.00 My Sessions My Cart My Orders  Suppert [
y ¥ o ! prort Balance: $0.00 My Sessions My Carto My Orders  Support [

Please complete your profile before continuing.

Schedule Session
Account Settings

Times' button.

E Please select a date and time on the left. Once you have selected your date, please click the 'Find Availab

My Account
Select a Date

Equipment Schedule New Session

General Settings
September 2020

Username * s T W Er
u 12:30PM CDT
Email * STATUS ACTIONS 3 ., . v . - Friday, September Food Protection

e Manager 526770
First name * 2020
18 minutes from now

Last name *

1 P
Phone mobile 3 5 7 12:50PM CDT

Phone home 9 51 - i { SQPTEWUEI' , Food Protection
. Manager 526770

Phone work CLI C K TO 5y 2 3001 2 3 .33 v:r;inutes from now
* At least one phone number is required. S C H E D U |— E 9 . 0
EXAM B 1:20PM CDT

Select a Time Friday SQ‘]{;{‘-H";:}.‘H' . Food Protection
Street1* . Manager 526770

Ul

Country * United States

Street 2 4t about 1 hour from now

- 12
1:40PM CDT

State/ Province/
I L i fal slatal




FOR SUPPORT 24/7 CLICK ON
“Need Help? Chat Now!”

2 ]

Have Questions? Test Your Equipment

ACTIVE EXAMS DATE & TIME STATUS ACTIONS

- Click for Support .

Always

Available 24/7 \
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THE DAY OF THE EXAM
Checklist for Taking your Exam.

\ To take your Practice Exam click on this LINK.
\ Have your Government-Issue I.D. ready to show the Proctor.
v Make sure you are in a private room with no distractions.

v Login 10 — 15 minutes before your scheduled time and “TEST
YOUR EQUIPMENT”.

\ Have a clean desk, no headphones, no smart watches and no
notes or documents on your desk. Cell phone is not allowed.

\ Watch this short video about your Pre-Exam Checklist.

v Mark every answer, and when the exam is completed, just
click on the “Submit” button.

v GOOD LUCK !!!



https://www.surveymonkey.com/r/ZXM3KM3
https://vimeo.com/246007317

DOWNLOAD PROCTORU EXTENTION

GET THE FIREFOX EXTENSION

ooooooooooooooooooooooooooooooooooooooooo

Home > Extensions > ProctorU
A : ;
EE Add h
you by the global leaders of online proctoring l I PrOCtorU e
) . .

Offered by: proctoru.com

Looking for the Google Chrome extension? Click here

For the exam, you need to download the “Proctor-U” extension.
This is a very easy process.

Follow the instructions in the next slides on how to install it.



Using Chrome~» Please download the ProctorU
extension as shown below.

Add "ProctorU"?

Open Chrome and click on ProctorU Extension 8

Link to download it.

IHome > Extensions > ProctorU R
can:

Read and change all your data on the websites that you visit

GE Display notifications
PrOCtorU to ch L] Communicate with cooperating websites
u Read and maodify data that you copy and paste

Offered by: proctoru.com
Capture content of your screen

Click “Add Extension” to Continue

Detect your physical location

* 220 | Productivity = 500,000+ users

Cancel Add extension

Your ProctorU extension has been added. See
the icon on the top right corner of browser. You
are done.

Afte.r th’fa exam, !’emove the ext.ensllon by “righ- N EI " ]
clicking” on the icon and choosing “Remove ” ProctorU
from Chrome”.

LY

Proctorl has been added to Chrome

e

Use this extension by clicking on this icon. Remove from Chrome...

Manage your extensions by clicking Extensions in Hide in Chrome Menu

the Window menu.
I Manage Extensions



https://chrome.google.com/webstore/detail/proctoru/goobgennebinldhonaajgafidboenlkl

Using Firefox? Please download the ProctorU extension as shown below.

1. Open Firefox and click on ProctorU Extension Link

to download it.

GET THE FIREFOX EXTENSION

A fully automated proctoring solution brought to

you by the global leaders of online proctoring

DOWNLOAD NOW

Looking for the Google Chrome extension? Click here

2. Click “Add Extension” to Continue

O & :i- https:f/www.proctoru.com/firefox

(=] Allow www. proctoru.com to install an add-on?
You are attempting to install an add-on from
www.proctoru.com. Make sure you trust this site

before continuing. g

Learn more about installing add-ons safely

Don't Allow b4 Continue to Installation

3. Your ProctorU extension has been added. See the icon on the

top right

corner of browser. You are done.

d:

- A

* D
* R

9 a ﬂ' https://www.proctoru.com/firefox

e o] Add ProctorU?
It requires your permission to:

« Access your data for all websites
« Clear recent browsing history, cookies, and related
« Get data from the clipboard
« Input data to the clipboard
« Extend developer tools to access your data in
open tabs

+ Monitor extension usage and manage themes

* Access browser activil uring navigation

I-- o n o @' =

0.0] ProctorU has been added to Firefox.

U Manage your add-ons by clickingﬂ-inthe =
menu.

lata

coess your location Allow this extension te run in Private Windows

isplay notifications to you
ead and modify privacy settings

Okay, Got It

4. After t

he exam, remove the extension by “righ-clicking” on

the icon and choosing “Remove from Chrome”.

&

Details

ProctorU|(disabled)

ProctorU Auto - A fully automated proctoring solution brought to you by the global
leaders of online proctoring, ProctorU.

Permissions



https://www.proctoru.com/firefox
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THE DAY OF THE EXAM STEPS
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STEP 2: CONNECT WITH A PROCTOdR

/ AND SETUP YOUR COMPUTER,‘
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FOOD PROTECTION MANAGER ~ FOOD HANDLER ~ ALLERGEN AWARENES & o
100% VIDEO BASED FOOD SAFETY TRAINING \

We Offer 3 Video Courses In Food Safety Training LO G I N S I G N U P

xj L ) N :
ﬁ C‘ ‘_r;'y ;’ & A \/

Food Protection Manager Food Handler Allergen A

www.alwaysfoodsafe.com

Login Portal

| LOGIN TO
/’ »- = Online, Video Bast YOUR

Accredited A|w0ys C_L/D
v ] ACCOUNT \ Ay s

. - Safety enaaaina for ¢
‘ '!’Y 1
- I Y
4 Always Food Safe is an Al -
S - el based e arig Email
~ web- e-learning prov
sectors : |
Enter email
We pioneered the use of fu

' |

Continue

If you do not have an account please register here.

FORGOT PASSWORD? CLICK BELOW

https://login.ncco.com/ForgotPassword

YOUR USERNAME IS YOUR EMAIL ADDRESS



http://www.alwaysfoodsafe.com/
https://login.ncco.com/ForgotPassword

Welcome

CONTINUE TRAINING / VIEW CERTIFICATE

BUY COURSES
ACTIVATE COURSE CODE
PROCTOR AN EXAM

Activated Courses

Food Protection
other counties, IL

B VIEW LEARMER MATERIAL

VIEW INTRO MATERIAL

Retake policy: If you fail your exam, this exam
allows 1 retake(s). You have 1/ 1 retake(s)
available

GO TO COURSE &

VIEW COURSE CERTIFICATE
SCHEDULE OR BEGIN YOUR REMOTELY PROCTORED EXAM







REMEMBER TO TEST YOUR EQUIPMENT AND
WAIT FOR THE PROCTOR TO CONNECT

Test Your Equipment Schedule New Session

Time to hit the books! \ ES YOUR

Your next exam begins in: EQU I PMENT ILS

ACTIVE EXAMS DATE & TIME STATUS ACTIONS

Food Protection Manager 618851 01/18/2021

Scheduled ‘ Rescheduls | Premium Reschedule Cancel
Always Food Safe A4:A0PM EST




A PROCTOR WILL CONNECT VIA CHATBOX, CHECK
YOUR I.D. AND SET UP YOUR COMPUTER

You are Wy being recorded.

You are currently being recorded.
To Connect Run the Logme||

pfOCtOf ’

Take Your Photo

1 Run the Logmeinrescue exe File

2. Proctory Chat Box

Don't see a chatbox?

3. Do Not Close the Chatbox

You are currently being recorded
You are currently being recorded
proctorl

Exam Rules Warning! Do not close this tab unless you have already completed your exam!

Need Help?







ONCE SET UP, THE EXAM WILL START!

@ Notify proctor

e Click to Speak
with the Proctor




WHEN THE EXAM IS COMPLETED, YOU WILL ANSWER
A FINAL QUESTIONNAIRE AND SEE YOUR RESULTS







MY COURSES STORE English ¢ Q PROFILE

Activated Courses

fnager - All

ERIAL

exam, this exam
[ 1/ 1 retake(s)

GO TO COURSE 2

VIEW PROVISIONAL RESULT

Exam Results

11/23/2020

BACK TO HOME

Provisional Score

Your official score will not be released until verified and approved by the certification organization

Remote proctoring verification usually requires 3-4 days after test completion due to joint review by the
Always Food Safe and our proctoring partners, or potentially longer if a session requires more in-depth
review. Once the review process is complete, your official certificate will automatically become available

91.25%

73 correct out of 80 graded questions

Section

allergens

cleaning 16 out of 16

facilities

food

personnel

regulatory




. CERTIFICATE

DOWNLOAD Y 4S8 »
YOUR CE
CERTIFICATE! /i Kato- Hickerson

for successfully completing the standards set forth for the

Food Protection Manager

which is accredited by the American National Standards Institute (ANSI) - Certificate for Food Protection (CFP)

Date Completed: Valid through:

Learner reference: Course Reference:

Certificate #: Exam Form #:

Instructor Name: Exam Form Name:

Exam Location:

Status:

Food Safe:

company

The Always Food Safe Company Nick Eastwood
899 Montreal Circle, St. Paul, 55102 :‘"“' é‘ éSi’_b President

www.alwaysfoodsafe.com The Always Food Safe Company







